
Do-it-Yourself LbyM Material
Preparation Guide

This guide assumes that you have had a chance to look through

each of the Curriculum Units (1, 2, 3, the Water and Soil

experiment unit).

I. Intro
II. Kit overview (include labeled arduino image and resistor chart)
III. Acquiring parts (Arduino, LEDs, resistors, boards, kit boxes, etc,

multimeters, tools) [lena chart]
IV. Soldering legs onto Arduino (lena video)
V. LbyM Arduino Sketch Installation
VI. Building an LbyM BasicBoard
VII. Testing an LbyM BasicBoard
VIII. Tips for successful technology implementation [debugging]

[troubleshooting] [when all else fails]



I. Intro
Learning by Making makes use of a variety of tools, including computer basic boards, resistors,
LED lights of various colors, wire of various colors, batteries of assorted strengths, and even
temperature and light sensors. The students will modify their Basic Boards as they follow along
with the curriculum, but there is a basic form of the BasicBoard that we suggest building for
them ahead of time. This will be the board that they improve upon themselves.

Traditionally, we have offered these materials to our students in the form of kits, which are
delivered at the beginning of Unit 1. However, there are no materials required to complete Unit 1
other than a laptop or computer with a Chrome internet browser.

Connecting the BasicBoard to the LbyM Web App
- Open serial port (software) that can connect to a USB-2.0 (hardware slot on computer)

- Note that some serial ports go to different hardware slots on a computer. Your
school’s IT department may lock your student’s serial ports. The serial port
connected to the USB connector needs to be open (or opened by your IT
department).

- 1 USB-A to USB-C cable (hardware)
- Arduino (metro-mini) Driver (follow link)

II. Kit Overview
There are two different categories of “kits” that should be built to support the LbyM learner. First
time set-up of the Arduino and Basicboard is more labor intensive, but those items are easily
refurbished for repeated use in the classroom.

Student Kits - Designed to accommodate one student per unit, contains all supplies for
ongoing use.

Classroom Supplies Sets - Intended for use in a classroom to accommodate 10-50
students. The Classroom Supply Set Includes enough of each item for each student to
use in an individual class.

● Student Kits:
○ Benefits: Handing out individual items, particularly the small ones, can take far

more time than providing each student with what they need for their use
throughout the curriculum. Students have a place to store their ongoing projects

https://learn.adafruit.com/adafruit-metro-mini/arduino-ide-usage


and materials (their kit box). Kits also allow the student to go at their own pace,
explore the unfamiliar items and play with materials.

○ The full list of materials is in the Supplies List, with links to examples. Here are a
few additional notes:

■ A small plastic compartment box with a lid is packed with the small parts.
This “Tiny box”, labeled with a contents list, is packed into a cardboard
“Student Kit” box that contains the larger materials, and is, in turn, labeled
with the full contents list. At the end of the Curriculum, students return the
kit box with all listed items, to be easily refurbished for new students.

■ Contents and packing instructions are listed here.
■ Box labels include a place for the student’s name. Putting a name label

on the side edge of the box assists with identifying kits when they are
stacked for storage.

■ Label templates are here: Label Templates

Class Sets: 30 of each item, or fewer, depending on class size

● Batteries - set of AA, AAA, 9V and CR2032 (coin) batteries
○ Note: when packing batteries, make sure the ends don't touch each other, or

come into contact with resistors, wires, or other objects. Stacking coin batteries
causes them to drain each other very quickly. Battery cases are recommended,
or batteries can be stored in a box, all standing upright and held in that position
by crumpled paper. Coin batteries can be stored by taping them flat on a piece of
cardboard.

● Wood and Metal Blocks
● Multimeters
● Gloves (nitrile exam gloves - not used as gloves)
● Painter’s tape

Note: Having a few extras on hand of all supplies is recommended.

https://drive.google.com/drive/folders/1NOR8lp5VZ6pokTrjn4ZFGtR0caF_jd2Q?usp=drive_link
https://drive.google.com/drive/folders/1LoiqE_daUWbW8TZhj2xMe1bogzbSGFeZ?usp=drive_link
https://drive.google.com/drive/folders/1DQDFaGd1ffr_tqmgYsGZWIvGQkBh6mik?usp=drive_link


III. Kit Parts

Part List with example URL links for supplies

Item (with URL) Quantity and Notes

Blank Breadboard 2 per student, one for pre-built board and one blank

BasicBoard Built from other items on this list, one per student

Arduino 1 per student, installed on Basicboard

Needlenose Pliers 1 per student

Wire Strippers 1 per student

12" Leashes 4 per student

USB C Cable 1 per student

Temp Sensors 4 per student

Light Sensors 1 per student

LED Bulbs 4 per student Tiny Box (loose), 2 for BasicBoard

Hook up Wire 5 wire bundles per student, wire for basicboard creation, 22 AWG solid core

Hook up Wire 1 wire set for classroom

Tiny Boxes One per student, holds small supplies

Student Kit box One per student, holds all student tools/supplies and also the tiny box

Elastic bands 5 per student

Header pins Strip of (minimum) 12 pins (or sections in groups of 3 to equal 12)

330 Ohm resistors 4 total - 2 packed in Tiny Box, 2 to create BasiscBoard

1K ohm resistors 1 per student

10K ohm resistors 1 per student

100K ohm resistors 1 per student

1M ohm resistors 1 per student

AA batteries Class set

AAA batteries Class set

9V batteries Class set

CR2032 batteries Class set

Metal Blocks* Class set

https://www.amazon.com/gp/product/B07NVWR495/ref=ppx_yo_dt_b_search_asin_title?ie=UTF8&th=1
https://www.digikey.com/en/products/detail/adafruit-industries-llc/2590/5629422?_gl=1*dn024i*_up*MQ..&gclid=Cj0KCQjwyL24BhCtARIsALo0fSAXL4UDFLZymXCj0PO4_tmlnymH7nu99ekikruK5z3gBcWb1QApdDcaAoEREALw_wcB
https://www.harborfreight.com/5-34-in-needle-nose-pliers-63815.html
https://www.amazon.com/Mr-Stripper-Stripping-Crimping-Electrical/dp/B086V5M1B4/ref=sr_1_8?crid=1Q22UDSGQQXOJ&dib=eyJ2IjoiMSJ9.TwAhXyeE4U-I0hBYqdP1PYAQ7T2gkrMfolUgjfqj1WAv7-bpnXzb8BZDtd2qNgrb2GMvCniN91SPkCxz7eWZKmq6uiWK0PrRyle8Ao5eqqySpAkEA0ZkNkBgmf_NLvLyiNphBj2F8dmxWs7EH_gLosHpLUxs6unHcGc2Ey22JNZ8E0rJHSI8NxGUqzhnfBlHWNou4o4icgzS-gMrfLDjUgHbOwlR_xmbyncIFT1gobCMsU9APFI8cOLuxE4B5uuW2ICOtT8kDAgPFHXIFxiAqxpnYzDAv24Ck1EqbwGHfUw.4sYnE9DBPi3rPLkVw2Hbdr9uTRdqTcw00Lji64kKxLw&dib_tag=se&keywords=wire+stripper&qid=1718400314&sprefix=wire+strippe%2Caps%2C168&sr=8-8
https://www.sparkfun.com/products/10373
https://www.amazon.com/dp/B0C622FVMX?ref=ppx_yo2ov_dt_b_fed_asin_title&th=1
https://www.amazon.com/BOJACK-Temperature-Sensors-TMP36GZ-Precision/dp/B08BFY91ZW/ref=sr_1_2?crid=2DH31T31KUD3H&dib=eyJ2IjoiMSJ9.VzayGqBKyq8z4l9agIQLpUhRYCfUVYWoI3Zf0AdbqI_54MV21DwSGsVnqwRupbg66GvzDQ7o6zcOgmIGYk0EE3MfhDajvXST3jZzuupcPIfHntZuR5dLuN6fuBeox5fxs6qRlaWzyCb4_c-O29MbLE17x49EXTpWwkoubVOZFdSeJNfH5JxDv3yo4Ztaj_RPpBWmASEohN4jiWMYbsLdusV3TsnttoNvoaeF72dIorQ.-hYUdg5gJiNYhvPj6bqlRdfklosnVnXhk82MBLRcMV0&dib_tag=se&keywords=tmp36+temperature+sensor&qid=1718401252&sprefix=TMP36%2Caps%2C329&sr=8-2
https://www.adafruit.com/product/2748
https://www.amazon.com/eBoot-Pieces-Emitting-Diodes-Assorted/dp/B06XPV4CSH/ref=asc_df_B06XPV4CSH/?tag=hyprod-20&linkCode=df0&hvadid=693609264841&hvpos=&hvnetw=g&hvrand=1104043543694691773&hvpone=&hvptwo=&hvqmt=&hvdev=c&hvdvcmdl=&hvlocint=&hvlocphy=9032097&hvtargid=pla-369941417757&mcid=5ea231ba612a3f49b0b6b3e9bae8a868&gad_source=1&th=1
https://www.sparkfun.com/products/11367
https://www.sparkfun.com/products/11367
https://www.grainger.com/product/FLAMBEAU-Adjustable-Compartment-Box-30C427?cm_sp=Home-_-Purchased_Products-_-HPMPPZ&cm_vc=HPMPPZ
https://www.amazon.com/dp/B00BT5CYLS?psc=1&ref=ppx_yo2ov_dt_b_product_details
https://www.amazon.com/gp/product/B07FKB9LPH/ref=ppx_yo_dt_b_search_asin_title?ie=UTF8&psc=1
https://www.mouser.com/ProductDetail/Adafruit/400?qs=GURawfaeGuAfltgGu9TGKw%3D%3D
https://www.amazon.com/gp/product/B0185FID32/ref=ppx_yo_dt_b_search_asin_title?ie=UTF8&psc=1
https://www.amazon.com/California-JOS-Carbon-Resistor-Tolerance/dp/B0BR66ZN6B/ref=sr_1_3?crid=2J63YGEIPP8PE&dib=eyJ2IjoiMSJ9.sjCrXtEr0PMGKZXQLPwE43Cm6Wuj_WtcdUxQqil3rZLHPHfHV8w9JiiI1zW4vmAA73Kx4_PY_ZRqCgGHMXXBHOX7i-uocgObGMMDW2XTFz4oqYUF9xgQ9ypDtLakZsL-9cR3YX9lw3dPyjkvJOWLxAeJotZDt0s5uy1PeY2XGdEe7H6kbaP2qXGeDZq60XeLrguvjoa7erAXgPC50pL9IGsWe8f7WEWKxkRX_OKdKu9LA3LyxRExtFFaxZ8AbJYeon0dUmJbniMH7iwGVWv4mC4eVDRa-l7kAdsjwgZBRqw.SeUz2BiV8tawh-fVyrdWpPZe5w0ZXLI9jm9nLdtvrUs&dib_tag=se&keywords=1K%2Bohm%2Bresistor&qid=1718401758&s=industrial&sprefix=1k%2Bohm%2Bresistor%2Cindustrial%2C156&sr=1-3&th=1
https://www.amazon.com/EDGELEC-Resistor-Tolerance-Multiple-Resistance/dp/B07QJB31M7/ref=sr_1_3?crid=253L54VETUVHR&dib=eyJ2IjoiMSJ9.6uu5JO-HYThVbztiQ4X9c_2BHpELZ7Y6Uz0tE7zQDjFL6R_ioPvyKDDQzauwyocWFv77Yvt-7KrLhdwAbgO9ETgOpyX9O4UGOyc93cTJbh6FR_9OS5Bi8VjZlrMqyRFbgjhqcIuKWM_BgpSR105H3TKghWGk5SPKq9upc97-M6F91dr5mv_yfhadE_GocR1iGIuLnIKIInm5K4cdiTnSQBkQ1L-RkovXRO84LptNg-ZQPqS9VO1n2vw1qkCuykHRWVYo1KWy7jkwJhf2Ejo6YOMgVx2FMK5wdKaDIa-AiqQ.op_oSwOEHfV3q1xw0Pv6LEm8qJ7WbUloLLSt-qPiFcs&dib_tag=se&keywords=10K+ohm+resistor&qid=1718401788&s=industrial&sprefix=10k+ohm+resistor%2Cindustrial%2C164&sr=1-3
https://www.amazon.com/EDGELEC-Resistor-Tolerance-Multiple-Resistance/dp/B07QK9793W/ref=sr_1_3?crid=2UVF0PLHVCM5M&dib=eyJ2IjoiMSJ9.vvzu6Guye8Bb9UqFs8aLdUlKuDeWgu-XvcIu6mH7_kTI7Yrc2SGeWtSj4Dk-VhTjckKDl_I2HbASStzEY_FVIbBuA9AmlBV6iugP1RjTtalHtOnN92nhPdCoWwlBXt4_NUm5VZS7VUAUoDLTHAmd-g_UZcAV71dAJX2N5R44BZerOIRF5Zy4ErjTfv0EIO-0BkzUisHmhQKHXFuiqDRyU8tg_ycKTVkuJM-o5lADX0KIh1zYSbpVWsKIYzxPnfITSjC19uCc9sQNAZO93IVXn0sj_CytA3p-8bSnQZCv29w.ku9pyRJf2M_OwFX91Ue5-E40QXUGl7MSFlYzt0AB9iU&dib_tag=se&keywords=100K%2Bohm%2Bresistor&qid=1718401813&s=industrial&sprefix=100k%2Bohm%2Bresistor%2Cindustrial%2C177&sr=1-3&th=1
https://www.amazon.com/Projects-10EP5121M00-Ohm-Resistors-Pack/dp/B0185FKM18/ref=sr_1_3?crid=1WNYQ723PQF9D&dib=eyJ2IjoiMSJ9.qEJU7aSeYxFt2JTFXNf7onayvTg0wRAF-4Pgl_q9SD1lOcteW457_WGZLPm5IOlExk0ytbuwArs7bX2AXRVT8TJr8eprvCjyOoLfrH46b7ANmjckjQ2dhqVBNJ6_q3b2Q2Llw2jSse0u-O0TgRIF31r90XhOIInSMn_y9ysCexdqGlAZiZ9ZgTZH4TMD5bfGGNXzrg-uayP5RqPyAmB_9XiLukdHfas4tTti9W_05AJF4H8C8FnZVUHg_ebhE4MF6Ii59AZ8QHmgsE2x_wo9IckKPkYtiGtLeR6bRwK73X8.HlZi-43SM_eybinIQhbhDAwIoXsd5HIKrH-dQZmmqHM&dib_tag=se&keywords=1M+ohm+resistor&qid=1718401845&s=industrial&sprefix=1m+ohm+resistor%2Cindustrial%2C223&sr=1-3
https://www.amazon.com/Duracell-Coppertop-AA-Ingredients-Long-lasting/dp/B0035LCFNQ/ref=sr_1_2_sspa?dib=eyJ2IjoiMSJ9.s_utV5WGUafhTj7DDq-B265g4Ls7G9IxIclYaTclrlKg6GM2pRIYX8bnCjmjvFvHibnAJ9JGbqyLGZhJqzkvUhCL9OHw2meyA-4RImDn1kF8A5wCM9uuHq5IFoU9DAN2lLeMDD1Rl8nfO25aO86xidPceA1mXQafG94c0wOzrk74BzhsAMzMlixufZ2AOKn049hAFb7UUKzqb6B4Y4wmjdD8zuFzIVK18Wyd5ZfSOFBcqCc17xlxpfjqjyAD0qNxuPw-uicm0mxk9Ql2EzFO_CUKHVad_lIy7Sw_xctta3M._8bLXr8syNmtOYauCvT6Opt9BocYwRJF5azMYxPdM1Y&dib_tag=se&keywords=AA+batteries&qid=1718401871&rdc=1&sr=8-2-spons&sp_csd=d2lkZ2V0TmFtZT1zcF9hdGY&psc=1
https://www.amazon.com/Coppertop-Batteries-Ingredients-Long-lasting-Household/dp/B006CSQXLO/ref=sr_1_2_sspa?crid=6N4NIN4CJEI6&dib=eyJ2IjoiMSJ9.sDk8mHya1-twxNdSRCH3uNREfSmWBeGVwkgaYFeoygtUCqd2J4qBcKjYilpmNxZi5nqcpJKS3YEEIv7hq0zJxJOGNyklx36dF9Dme4bjflwjKRdIuqOdnkGQUHYog4xAFftktJF_MMg4KEqGF_NbI2PRuHfOswhFhXoyUvPscjI9xfArIyRzkrSTuXg_p-xxpIzqAm-zLtZzcNDHIR338ezK_QL3CJsDluB9fQGt77FkY-nN1vs8bwhpGGpIp-dlkGIP8yxVULktWVM19stLoixQqnrEoP7fRZ3wfXjTOl4.duvnMJHlzrsxiWDUIt__ZE8K19vE3IjfPdJ0gEHRGq0&dib_tag=se&keywords=AAA+batteries&qid=1718401900&rdc=1&sprefix=aaa+batteries%2Caps%2C181&sr=8-2-spons&sp_csd=d2lkZ2V0TmFtZT1zcF9hdGY&psc=1
https://www.amazon.com/VONIKO-9V-Batteries-Alkaline-Battery/dp/B07RZ9PMQH/ref=sr_1_2_sspa?crid=1UVKLUIOLODDQ&dib=eyJ2IjoiMSJ9.xSDp2uqjo-XneTILvkAtpkt0y7Ed1ttHtLqSnHeANn9HZgh6uofYjz2Zvj8JgQX29bSi8Ttu_NJ2TxHFcHDliAxFOlkeK9n5IIZ1RtZ9MBG14ngsQtMtupV2aDnhpS8uMLLIowP7Rcb9e-V0DiLydt3-nig1ymyuoJvcTHT00gZoydfTkvnGFN1J4NK1WPIxdrl3IY-l7MG6Wxzx4x6Qt63_zuHOEN9opUFU4L0vRZ_lQM8Sl3AR3PXUd0P5TKYtIXGytPwIwZpAj-nB05KLNo2omUlbJzQy0T8Z82gLSAg.xCWLS2xy3zP4PE51KOhlOvlWQlmw_av32DwaME5Fi_4&dib_tag=se&keywords=9v+batteries&qid=1718401921&sprefix=9v+batteries%2Caps%2C221&sr=8-2-spons&sp_csd=d2lkZ2V0TmFtZT1zcF9hdGY&psc=1
https://www.amazon.com/Duracell-Lithium-Battery-Features-Compatible/dp/B0C15WJXL2/ref=asc_df_B0C15WJXL2/?tag=hyprod-20&linkCode=df0&hvadid=692875362841&hvpos=&hvnetw=g&hvrand=14053385741554142898&hvpone=&hvptwo=&hvqmt=&hvdev=c&hvdvcmdl=&hvlocint=&hvlocphy=9032113&hvtargid=pla-2281435182458&psc=1&mcid=8650ba2152d53f47a10a39ae2a26f808&hvocijid=14053385741554142898-B0C15WJXL2-&hvexpln=73
https://www.fishersci.com/shop/products/steel-cubes/S40944#?keyword=metal%20cubes


Wood Blocks* Class set

gloves Class set of at least one per student (not used as gloves)

Mulitmeters Class Set

Painter's tape Class set: One or more roll to be shared

Small Label Stickers Blank stickers for printing small labels for Tiny Box

Larger Label Stickers Blank stickers for printing Kit box and Class Set stickers

A few notes on materials:
*The wooden blocks and metal blocks need to be identical in shape in order to properly work in
the curriculum. When we were originally designing the lesson, we had to reach out to local
woodworkers and smiths. We gave examples of blocks that you can order, but please note that
the lesson requires blocks that are identical in all dimensions. We suggest reaching out to your
local tradespeople to inquire about custom blocks. It will be far easier to have the blocks made
this way than trying to match from two different vendors. Also, the shape can be whatever you
like so long as they are both the same.

IV. Soldering

Safety
This video was created by an independent contentHow to Solder Safely | Soldering

creator and covers everything from how to properly hold a soldering iron to how to
check and make sure that the solder you are using contains lead or not. If you are using
a lead-based solder, you must perform your soldering in a room with proper ventilation.
If you are using solder that is not lead-based, a table-top fume extractor should be
adequate. It is still very important to ensure that the room you are working in has
minimal ventilation (open windows and doors, at the very least).

The Arduino is delivered unassembled, so there will likely be some soldering involved
before you can use the Arduino. This is also true for the Light Sensor. In this section
you will find instructions for soldering the header pins onto the Arduino. The same
method can be used for the Light Sensor pins. If you are not familiar with soldering, we
have collected several resources here:

1. This video was created by the EdEon STEMGetting Jiggy with Hannah and Amber

Learning group in cooperation with Twiggs Space Labs. The video features instructions

for how to assemble a Jiggy Bot (sold by Twiggs Space Labs), but the advice and safety

suggestions are applicable to any soldering work.

https://www.youtube.com/watch?v=3ht_JmfaCNM
https://youtu.be/2iPcyWh_MQI
https://www.amazon.com/gp/product/B00DNN5HOK/ref=ppx_yo_dt_b_search_asin_title?ie=UTF8&th=1
https://www.amazon.com/Supmedic-Nitrile-Disposable-Powder-Free-Latex-Free/dp/B0C9S5PMSD/ref=sr_1_5?crid=YAJWNIOAFXNP&dib=eyJ2IjoiMSJ9.MfLrriw8JapCpCs0KYk23gOl3g-ACezndw3P5J8Tm6Kg6FSVX68_3DUlw2V50eh0BBYWJciYmcUVKOPmXb8-AKsyfWbeldHjU-wnk9ks-B-ulj0enIm3mApCDzOtV9q0Ds5pYdgecA5OWSFPx7ywiVD2_ris88mXdRTROzMKVoScYAzItuZSBi0dLf9WvD1AZHCcut1T8jQGmHKLP_wvuwiuFTyfP12gp91Owadeq4vTFpmdsJW5alGE09w5TTTVtOHCMcrRLDiqLKStQ-r3GiqmaCpZQ0nIIFehuKDSVP4.sSMQm36ISdLqIcC2aMzR-ekc4WkDL0WnCNYWMzrNV7Q&dib_tag=se&keywords=latex-free+gloves&qid=1718401962&sprefix=latex-free+glove%2Caps%2C160&sr=8-5
https://www.amazon.com/gp/product/B00KXX2OYY/ref=ppx_yo_dt_b_search_asin_title?ie=UTF8&psc=1
https://www.amazon.com/Painters-Painting-Adhesive-Decoration-Labeling/dp/B0BPS5QB4D/ref=sr_1_4_sspa?crid=E1I7O9T4183W&dib=eyJ2IjoiMSJ9.MVQs3MDGHt4bjeUcI-doMr2Rtg8y1EoG0hvEuA0t1dgavnhZpXOEtixj2kIwpT29-28r2CjtUiuUIfOSVqJyid7tkxXDlOvjLpovMm3YVDaEqcPRblqsxxCiG_eHrnGIpwQVFwFOQ9_VWmcShFwgKAHJiYRkgR3r1UkpCPr506jwedS4t35cfh5Wqdg8mw6d1qoILuPQ3Kvz36MtnQgodw6LVvPiNxxjJ_gnpy12KRZfZR1yPb59SD3HauL7lFB74I-cuksFuushaCXhW2oBPL9t_tmRpD9-yEc1jUh7B6g.woGFDHxLYo8C5oQSOwzEK6ulXIyOB0lwxzCViH14h3o&dib_tag=se&keywords=blue%2Bpainters%2Btape&qid=1729099508&sprefix=paitner%2Caps%2C164&sr=8-4-spons&sp_csd=d2lkZ2V0TmFtZT1zcF9hdGY&th=1
https://www.amazon.com/gp/product/B00005QXYE/ref=ppx_yo_dt_b_search_asin_title?ie=UTF8&th=1
https://www.amazon.com/gp/product/B00005QXYE/ref=ppx_yo_dt_b_search_asin_title?ie=UTF8&th=1
https://filtrabox.com/understanding-the-importance-of-ventilation-while-soldering-indoors/
https://www.amazon.com/Extractor-TOAUTO-Noise-free-Adjustable-Adsorption/dp/B09TPXKWVZ/ref=sr_1_17?crid=1X9SVNG90Y8RI&dib=eyJ2IjoiMSJ9.X6dpK7fQRPOWJLO8DedHpwO6JnPLrcud7JJiQJ1owpPZlDj-lAv2qw0PsXxAWATDhnBV_WvQlRDWSpVScEDuyxDxWs030NtK6XheFZszAC3KT2kNjTATzdCwFzhRV-Bk8sfUSRwzPefx3--3IEwVNe6pLoQobOS2XZjjdlAxi3juc3FsfsnYaIpsKVg4wGrZmd19IalCpnenbCezDVfGuydYmo5qwcIHLqKbWuZbsS66yw2uYTF85mv1Hm5evashkIvUvm32u3Zsck25tehNZ04QZWA0vOH4Ho3N2mjMmP0.DkSLRngPoAoe0emVDmi9lJss1PlM8SEn6Z6MUkGoKlk&dib_tag=se&keywords=solder+fume+extractor+fan&qid=1730145176&sprefix=solder+fume+extractor+fa%2Caps%2C173&sr=8-17
https://www.digikey.com/en/products/detail/adafruit-industries-llc/2590/5629422?_gl=1*dn024i*_up*MQ..&gclid=Cj0KCQjwyL24BhCtARIsALo0fSAXL4UDFLZymXCj0PO4_tmlnymH7nu99ekikruK5z3gBcWb1QApdDcaAoEREALw_wcB
https://www.adafruit.com/product/2748


2. This video was created by anHow To - Solder Pin Headers to an Arduino Pro Mini

independent content creator and is useful because it instructs soldering for the same

Arduino we use in the LbyM curriculum. Note: This video shows soldering happening

with the Arduino situated on a breadboard, but that board is not connected to any

power source. Be sure to solder using a breadboard that is unplugged and disconnected

from any electrical sources.

3. Helping Hands are devices that can help hold onto parts as you solder. This is an example

of one we have found useful.

4. Here is an example of a soldering iron to purchase if you do not already have one. Be

sure to have a stand to place the iron on while you are not using it.

5. Here is an example of solder to use that is lead-free.

V.   LbyM Arduino sketch installation
In order to use the Arduino with the web app, the Arduino microcontroller needs to be primed
with initial software to be useful for use in the curriculum.
Note: These instructions are geared to I.T. or individuals with knowledge of loading
sketches on micro-controllers.

A. Required hardware and software to load the initial Arduino software

• An appropriate Computer OS to run Arduino IDE and Google Chrome (i.e. Windows
10 or 11, Apple MacOS, Linux, Google ChromeOS on a Chromebook)
• If using Windows or MacOS, CP210x USB to UART Bridge VCP Drivers are required.
They can be obtained from this site.
• Google Chrome browser (Microsoft Edge can also be used)
• A supported Arduino micro-controller (At this time, only the Adafruit Metro Mini V2 is
tested and used in the curriculum).
• Arduino IDE 1.8.x (Use the legacy version as this has been fully tested, the newer 2.x
has not been tested).
• The initial LbyM Arduino sketch as a zip file. The zip file can be downloaded from
here.
• USB A to USB C cable. USB C to USB C cable may be used as well.

B. Installation of drivers

If the computer used to load the initial LbyM Arduino sketch is running Windows OS (10 or 11)
or Apple MacOS, software drivers will be required before installation. Make sure the user
account has administrative privileges before proceeding. Below are the steps for installing the

https://youtu.be/37mW1i_oEpA
https://www.amazon.com/dp/B079CHJQKH/ref=sspa_dk_detail_3?s=hi&sp_csd=d2lkZ2V0TmFtZT1zcF9kZXRhaWxfdGhlbWF0aWM
https://www.amazon.com/Weller-Digital-Soldering-Station-WLC100/dp/B000AS28UC/ref=sr_1_17?crid=3APBHKAGN8BBV&dib=eyJ2IjoiMSJ9.rDUodxabL7AbKnJR_hLiWKAJ8hBvfWiyr3CMctPG2fxXF7Z05stWbwU3eg4hAItR_S7_0RgYw7DSp3A4Bl5TxGy0th44eU7fVQ0kb9bP2tWQYCjhlF4PxtriNqpih_yWvswEtn3QG6TM9VXWsvC8zV7WZSM5GTpkZDnZDDQvy7EGjhZYLV4okKp2w0oeuQ1JPd0WV8xecFtvIRELytmhTdLVQ4iV_MLManmUFMtH3ZJzsoLIHLQzCVzdMPL6psaFp-nAuCLfENWIFEgwdVtVQFRtj9EULP8EEolfnjwSLgI.OFcVgrcxqA7eC4yo6GL_G8pEn9O0kqeBpCZO7oi1ung&dib_tag=se&keywords=soldering+iron+with+stand&qid=1730144889&sprefix=soldering+iron+with+sta%2Caps%2C169&sr=8-17
https://www.amazon.com/Dia0-032in-0-11lb-Precision-Electronics-Soldering/dp/B07Q167J98/ref=sr_1_5?crid=2OBP9ZDO59H17&dib=eyJ2IjoiMSJ9.ABcrlSd0nHVpgKwVpSxP1AbjzNv9nxDio9rct3RbLVkTMvDtkw8L3cHILm7B5iCLzh13jVvj40XEv1ZC3dh-1Uhw2w2OUANXpocipuba_xj4h-D4HXVHgRdujvxHgiwa8aGZminhfkJoVIG7P2304fGW4z5i88pHY98VyloXnHbqtQfShLCgbhJ1HuS1z09FpLJU1XQb9_wwfVy-gHy58DA_LYqJSaMRpFkECd1ZrO5GqK_3covtykbshKNUM2BNCOam2umncanHoRQmvNdvlettWxnZ7IQunlgQPeSw0Mc.mVeIYotPWKP7f3VUyMrPjTwM7ueHclsQWuKN9-vgVu8&dib_tag=se&keywords=lead-free+solder&qid=1730145013&sprefix=lead-free+solde%2Caps%2C178&sr=8-5
https://www.silabs.com/developers/usb-to-uart-bridge-vcp-drivers
https://drive.google.com/drive/folders/1rpu83APjZ7HDJoWLFWzP-83gfHzgpXgC?usp=drive_link


driver on a Windows-based PC. Drivers are required for ANY computer that is using an Arduino
for initial programming and/or experiments, including student computers using Windows (10 or
11) and Apple MacOS.

1. If you haven’t downloaded the drivers, take the opportunity to download the drivers
from the Silicon Labs site here.
2. Press downloads to show all the downloads
3. Look for the “CP210x Windows Drivers with Serial Enumerator” driver.
4. Click the link to download the driver zip file.
5. Unzip the zip file to a folder.
6. Navigate to the newly unzipped folder and look for the file
CP210xVCPInstaller_x64.exe
7. Run the file. Windows UAC may require elevation of privileges to install. Click “Yes” to
continue the installation.
8. Click “Next” to continue
9. Accept the agreement by clicking the bubble selector and select “Next”
10. Installer will install the drivers
11. Click “Finish” to complete

Note: Windows Arm drivers are only available in the Windows Universal driver package. Follow
the CP210x_Universal_Windows_Driver_ReleaseNotes.txt file in the folder to proceed with
installation on Arm hardware.

Below are the instructions for installing drivers on Apple MacOS.

1. If you haven’t downloaded the drivers, take the opportunity to download the drivers
from the Silicon Labs site here.
2. Press downloads to show all the downloads
3. Look for the “CP210x VCP Mac OSX Driver” driver
4. Unzip the “Mac_OSX_VCP_Driver.zip” file and navigate to the extracted subfolder
5. Mount the DMG file and double click on Silicon Labs VCP Driver. On MacOS 10.13
and later, the installation of the driver may be blocked.
6. To unblock, open the System Preferences Security & Privacy pane and unblock the
system extension. See Apple Technical Note TN2459 "User-Approved Kernel Extension
Loading" for more information.

Note: Linux and ChromeOS DO NOT require driver installation.

C. Installation of Arduino IDE

The Arduino IDE is required to load the initial sketch. To install the Arduino IDE follow the
instructions below:

https://www.silabs.com/developers/usb-to-uart-bridge-vcp-drivers
https://www.silabs.com/developers/usb-to-uart-bridge-vcp-drivers
https://developer.apple.com/library/archive/technotes/tn2459/_index.html


1. In a browser, navigate to the Arduino IDE download site
2. Scroll down the web page until you find the section “Legacy IDE (1.8.X)”
3. Look to the right of the section and download the installer most appropriate for the
operating system that is in use.
4. Run the installer file

a. For Windows users, run the arduino-1.8.19-windows.exe installer file. Windows
UAC may require elevation of privileges to continue. Follow the screen instruction to
complete installation
b. For MacOS users, download and unzip the arduino-1.8.19-macosx.zip file.
Copy the Arduino application bundle into the Applications folder.

5. Once complete, proceed to next section for obtaining the LbyM8 Arduino sketch

D. Obtaining and unzipping the initial LbyM8 Arduino sketch

To obtain to LbyM8 Arduino sketch, download the zip file from here. Unzip the file to a
convenient location. This could be in your downloads folder or on your desktop. The folder
should contain several files. The file needed later is the lbymDriver2021.ino Arduino IDE file.
Locate it, and make sure you can easily find it later.

E. Configuring Arduino IDE
Start the Arduino IDE from the Start Menu for Windows users or the Applications folder for
MacOS users. The repository to Adafruit’s git repository needs to be added. To begin, navigate
to File>Preferences. This will open a window with preferences for the program.

Look for the section called “Additional Boards Manager URLs.” Inside the text box, type the
following URL to the Adafruit Boards definition json file:
https://adafruit.github.io/arduino-board-index/package_adafruit_index.json

Click the “OK” button to complete this part of the configuration.

Assuming the computer is online, the Arduino IDE will download Adafruit’s board definitions
from their git site. Next, we need to ensure the Arduino board libraries are added to the
installation.

Navigate to Tools>Board>Board Manager.
Once in the “Board Manager…” window, make sure that Arduino AVR Boards, Arduino
MegaAVR Boards, and Adafruit AVR Boards libraries are installed. If not, search for each library,
select it, and click install to download and install the library in the Arduino IDE environment.
Once installed, the libraries are instantly usable.

Click the “Close” button to complete this part of the installation.

https://www.arduino.cc/en/software/
https://drive.google.com/drive/folders/1rpu83APjZ7HDJoWLFWzP-83gfHzgpXgC?usp=drive_link
https://adafruit.github.io/arduino-board-index/package_adafruit_index.json
https://adafruit.github.io/arduino-board-index/package_adafruit_index.json


Next make sure the Adafruit development libraries are installed. Navigate Sketch>Include
Library>Manage Libraries…

Search for Adafruit by typing in the search bar on the top of the window. It will take time to
populate the window. Make sure that the following libraries are installed: AdaFruit BusIO,
Adafruit Circuit Playground, AdaFruit GFX Library, Adafruit GPS library, Adafruit ILI9341,
Adafruit LED Backpack Library, Adafruit Sleepydog Library, Adafruit STMPE610 library, Adafruit
Touchscreen, Adafruit Zero DMA library, Adafruit Zero FFT library, and Adafruit Zero PDM
library.

The Arduino IDE interface is sluggish. Please allow some time for the interface to respond to
commands. Once all libraries are installed, click the “Close” button to complete the
configuration. Configuration only needs to be completed once for the first time.

F. Loading the initial LbyM9 Arduino sketch
Next, load the LbyM9 Arduino sketch by navigating to File>Open. Navigate to where the sketch
was unzipped from the prior step. Locate the lbymDriver2021.ino file. Once selected, click the
“Open” button to open the sketch.

Your Arduino IDE sketch should now be open with three tabs in the interface. Next, we need to
attach the Adafruit Metro Mini V2 to the computer using either a USB A to USB C or USB C to
USB C data cable. A green power-on LED should be lit.

From within the Arduino IDE, select Tools>Adafruit Boards>Adafruit Metro. This library is
needed to flash the board with the sketch.

Next, select the communications port by navigating Tools>Port>COMx. On a Windows platform,
this may look like COMx, where x is the index number for the COM port. Other platforms may
look different. For example, on a Linux or Android system, this may look like /dev/usbTTYx.

Check the code by clicking on the verify button; it is the little circle button with a check mark in it.
The IDE will now test-compile the code. Should the test be completed without errors, a display
should be indicated in the terminal window indicating how much onboard memory is used. Any
errors should be resolved prior to continuing.

Next, write the sketch to the Arduino by clicking the upload button. The process will be similar to
the verification process. The code will be compiled, written to the non-volatile portion of the
on-board memory, and output written to the terminal. The interface will indicate when uploading
is done. Once done, testing is usually done to validate the load process.



G. Testing the installation
Open Google Chrome or a Chromium based browser and type http://app.lbym.org in the
address bar. Press enter to navigate to the web site. Assuming the Arduino is still connected to
the computer via USB cable, press the “Connect” button.

Another window should appear with the COM port of the Arduino listed. Select “CP2102N USB
to UART Bridge Controller (COMx).” Click Connect to complete connecting the browser to the
Arduino.

If you are testing the Arduino without being attached to a basic board, follow the instructions in
this section. In the terminal window, type the following:

ob1on [enter]

A red LED on the Arduino should now light up. This is an initial indicator that the Arduino is now
properly loaded with the sketch and commands are being sent from the browser.
Communication is happening, and the Arduino is now initialized and ready to be used. Type:

ob1off [enter]

in the terminal to turn off the red LED. Initial testing is done.

If you have the Arduino attached to a completed basic board. You can test the initial
configuration of the basic board before deployment by issuing the following commands in the
terminal:

dp2on [press enter]

The red LED will turn on.

dp2off [press enter]

The red LED will turn off.

dp3on [press enter]

The white LED will turn on.

dp3off [press enter]

The white LED will turn off. Once the procedure is complete, the basic board with Arduino is
now ready for student use in the curriculum.

http://app.lbym.org/




VI. Building the BasicBoard

Tools you will need:

● Bread board
● Arduino
● Solid core wire (red, black, yellow)

o Note: DO NOT use stranded
wire.

● Uninsulated Copper wire
● LEDs
● 330 ohm resistors
● Wire cutters
● Wire strippers
● Needle nose pliers

Step one: When placing the Arduino make sure the breadboard is horizontal and
the blue ground rail on top of the red power rail. The Arduino will be placed with
the usb connector facing the top of the board, the first pin on the left will be placed
on the 8th row down and the 2nd column from the left.

Step two: Using the wire cutters you will need to cut:

● 3 black wires 2.5 cm long
● 2 red wires, one 2 cm and one 4 cm

long

● 1 yellow wire 5.5 cm long
● 2 copper wires 2 cm long
● Both legs of 2 resistors in half

Step three: Using the wire strippers, strip approximately 0.5 cm of insulation off
both ends of each wire

Step four: placing the wires, LEDs and resistors. Use pliers to bend and place wire
when necessary. The board should now be vertical with the blue ground rail on the
left.

1. Place the shorter red wire from the 3V pin on the left side of the Arduino to the red power
rail on the left

2. Place one black wires from the first GND pin on the left side to the blue ground rail on
the left

3. Place the longer red wire from pin 2 on the right side to the 24th row (if it’s one up or
down that is ok)

4. Place a red LED with the longer leg in the same row as the red wire and the shorter leg
one row down.

5. Place one leg of a resistor in the same row as the short leg of the red LED and the other
leg in the same row on the opposite side of the break of the bread board.

6. Place one black wire from the same row of the resistor to the blue ground rail on the left side



7. Place the yellow wire from pin 3 on the right side to the 28th row (again if one up or down that is

ok)

8. Repeat 4-6 using a white LED

9. Place cooper wires in ground rail on the left side between the black wires

When you’ve finished placing the grounding wires the board should look like this:



VII. Testing the BasicBoard

Part 1: Laying out LbyM

The purpose of this testing process is to ensure that the standard red and white LEDs on a
default BasicBoard, and more fundamentally the pins transmitting signals to them, both operate
correctly. This is done by using the LbyM web app to send commands to the Arduino, a
schematic of which is displayed in Figure 1.

Figure 1: LbyM webapp layout (Source: Experiment UNIT Light and Energy)



Part 2: Codifying the Code

Figure 2: Test code

*The numbers on the left merely indicate where in the Text Editor each line is, which doesn’t matter,
although I recommend just placing it below the rest of the code.

1. Begin by going to the LbyM web app, which is currently hosted at this link.
2. Log into your account via Login in the top left.
3. In the upper middle, click on +New.
4. In the list this opens, LEDs will provide the ideal code layout for us to work with, so click

on that and wait for it to open.

5. Enter Figure 2’s code as described in the dark section labeled Text Editor from Figure 1:

1. Scroll below the rest of the code to an empty spot
2. Type “to test”
3. Press Enter to get to the next line
4. Press Tab, then type “dp2on”
5. Press Enter to get to the next line, your cursor should be spaced slightly to the

right and have the vertical line to its left you can see from positions 72 to 77 in
Figure 2.

6. Type: “wait 10”
7. Repeat this process with until after you have typed “dp3off”
8. Press Enter and then Backspace once to get to the same horizontal position as

“to test”
9. Type: “end”

6. Click on Untitled in the upper left and create a name; “BasicBoard Testing,” for instance.
7. Press Save in the upper right corner.
8. If you click on your profile image in the top left, this should now be in your program list

for future use.

https://cloud-dev.d2bs4q58dinnok.amplifyapp.com/pr585479370d484093


Quick Overview
● to test: A header for the code which indicates that you type “test” in the Terminal window

(see Figure 1) to initiate it.
● dp2on: A command which instructs the pin labeled “2” to begin transmitting power,

which on the BasicBoard should be connected to the longer (anode / positive) lead on
the red LED and cause it to light up.

● dp3on: A command which instructs the pin labeled “3” to begin transmitting power,
which on the BasicBoard should be connected to the longer (anode / positive) lead on
the white LED and cause it to light up.

● dp2off: A command which instructs the pin labeled “2” to cease transmitting power,
causing the red LED to darken.

● dp3off: A command which instructs the pin labeled “3” to cease transmitting power,
causing the white LED to darken.

● wait 10: Instructs the code to wait for a time period of 10 deciseconds before continuing
with the next command. This corresponds to a time period of one second, but you may
adjust this if it is too long or short.



Part 3: Evaluating the LEDs

Now with the code prepared, we can begin our testing. As a reference point, here is a basic
schematic of a BasicBoard:

Figure 3: BasicBoard schematic (Unaltered image source: UNIT 3 Doing Science with Sensors)

1. First, check to make sure that the power and grounding wires and ground wires are
oriented as shown in Figure 3 above: with red wires in a hole next to the red and black
wires next to the blue line. If it is backwards, dismantle the entire BasicBoard and
reassemble as shown.

2. Open the LbyM program you saved with the testing code described above.

Figure 4: USB orientation



3. Take a USB cable and plug it into the Arduino on the BasicBoard, underside up as
shown above in Figure 4, with the other end in your computer’s USB port.

Figure 5: Correctly lit Arduino

Figure 6: Incorrectly lit Arduino

4. An Arduino in ideal condition should have a green light labeled ON activate as seen in
Figure 5 once the USB is plugged in.

a. If the green light doesn’t turn on as shown in Figure 6, continue with the rest of
the testing. If it passes the rest of the testing, place it in a pile labeled something
like “fully works except for green status light”.



Figure 7: Correctly connected Arduino Figure 8: Incorrectly connected Arduino

5. With the Arduino plugged in, click Connect in the upper right of the LbyM webapp. This
will open the window shown in Figures 7 and 8.

6. If the Arduino properly connects as shown in Figure 7, continue to Step 6.
a. If the Arduino does not properly connect as shown in Figure 8, see

Troubleshooting in Part 4.
7. Click on the listed option and press Connect, which will trigger a red light labeled L to

flash briefly and also change Connect to Disconnect.



Figure 9: Initial state Figure 10: Red LED activated

Figure 11: White LED activated Figure 12: Final state

8. You are now prepared to test the BasicBoard. In the Terminal window (Figure 1), type
the word “test” to initiate your code, which should activate the red and white LEDs in the
pattern seen in Figures 9-12. If it does, the Arduino has fulfilled its parameters and
earned the singular honor of being placed in the “tested and working” pile. If either or
both of the LEDs don’t activate, see Troubleshooting in Part 4.

9. Now, repeat with the rest of that pile.



Part 4: Troubleshooting

For this test, our failure condition consists of either the red LED, white LED, or both not lighting
up when they are supposed to. The reasons for this happening boil down to five basic causes,
which we’ll go through:

1. Issues with the code
i. This is the simplest problem, which you can check by seeing if the code

matches what is given in Figure 2.

Figure 13: Testing LED with coin battery

2. Issues with the LEDs
i. Remove the LED that didn’t light up and check to ensure that the longer

lead is linked to the colored wire and shorter lead is linked to the resistor.
ii. If they are connected as intended, check with a coin battery as shown in

Figure 12 above, with the longer lead on the labeled, positive side.
1. If it does not light up, flip the LED to double-check. If the LED

lights up, reinstall into the BasicBoard as per Figure 4 and
continue troubleshooting elsewhere.

2. If it doesn’t, throw away the faulty LED and replace with one of the
same color and retest. If it continues to fail to light up, continue
troubleshooting elsewhere.



3. Issues with the connections (colored wires, grounding wires, or resistors)
i. Review the BasicBoard image in Figure 4 and ensure that the

connections in the board you test are accurately linking up as shown.
ii. Common problems may include:

1. Some connections are simply missing, such as the grounding
wires.

2. Some parts are placed incorrectly, such as the colored wires and
resistors being aligned with the same LED lead, see Figure 14.

3. The power wire being connected to ground (next to blue line) or
ground wire(s) being connected to power (next to red line).

4. The colored wires not being correctly connected to the “2” or “3”
pins.

4. Issues with the Arduino
i. If the LEDs and connections appear to be accurate (along with the code),

swap the Arduino with another from a BasicBoard (which I will label
BasicBoard X for clarity) which was successfully tested and retest both
BasicBoards.

ii. If the LEDs and connections appear to be accurate, swap the test Arduino
with one from a BasicBoard previously established as working and test
both BasicBoards. For clarity, I will refer to the board you are testing as
BasicBoard A (with Arduino A) and the one which was successfully tested
before as BasicBoard B (with Arduino B)

1. If BasicBoard B with Arduino A succeeds while BasicBoard A with
Arduino B fails, then the Arduino is not the problem and you
should continue troubleshooting elsewhere.

2. If BasicBoard A with Arduino B succeeds while BasicBoard B with
Arduino A fails, then the Arduino you are testing (A) is not working.
Place it in the “not working” pile and either dismantle BasicBoard
A or replace it with a new Arduino if there is a ready supply and
retest.

5. Issues with the breadboard
i. If the code, LEDs, connections, and Arduino all appear to be working, the

problem may be the breadboard. If there are blank breadboards available,
dismantle the BasicBoard and reassemble it there with the same layout
as in Figure 4, then retest.

6. If all is lost
i. If all five cases have been tested and there still appears to be an

unknown problem, place it in the “not working” pile and move on to the
next one.




